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Guidelines for Managing Your Browsing History, File Cache,

and Downloads Folder

The internet browser history and file cache should be cleared on a regular basis, to minimize the security
risk of leaving data with PHI on your personal computer. Your Downloads folder should also be cleared
regularly to minimize this same risk. This page provides instructions on managing these items for Google
Chrome and Microsoft Internet Explorer. If you are having problems or issues with any of these
instructions, please contact your local technical support representative for assistance.

Google Chrome

You should be clearing your browser cache whenever you exit Google Chrome; however, an alternative is
to set up Google Chrome to always allow you to browse in what is known as Incognito mode. Incognito
mode ensures that browsing history, cookie information, and browsed pages are not saved on your
computer. Follow the steps below to clear your browsing cache and history, as well as set up your Google
Chrome browser to always start in Incognito mode.

Enabling Google Chrome Browser History and Clearing File Cache

1. Inthe upper-right corner of your Google Chrome browser window, click the Customize and

control Google Chrome icon ( = ), and select History from the set of options.

T [
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2. The History window appears. Click the Clear Browsing Data button.

W O eHealth Ontario | It© x ] 4 History x ! ﬁ

€ - C ff [ chromey/history
it Apps For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks

Chrome History |

I History
| Clear browsing data... || Remove selected items Shol
Extensians mo

Settings Today - Tuesday, August 30, 2016

[] 1:50 PM o http:/fwww.ehealthontario.on.ca/en/ v

About ] 1:50 PM & ehealth ontario - Google Search ww

] 1:49 PM G Google v

gle.ca

[C] 1:49 PM G Cntario Laboratories Information System - eHealth Ontarnio | It's Working

] 1:49 PM & Google www.google.ca
] 1:49 PM _;,'_a Cntario Ministry of Health and Long-Term Care www.health.gov.on.ca
[ 1:48 PM G https)/fwww.google.ca/webhp?sourceid=chrome-instant8tion=18&espv=

3. The Clear browsing data property sheet appears.

0 eHealth Ontaria | It X &t Settings - Clear brov x

€& = C A |[ chrome://settings/clearBrowserData
i Apps For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...

Clear browsing data

Psst! Incognito mode (Ctrl+ Shift+ N) may come in handy next time.

Obliterate the following items from:| the beginning of time *

[ Browsing history — 7 items
¥ Download history
| Cookies and other site and plugin data

®

Cached images and files — 389 MB

| Passwords

| Autofill form data

| Hosted app data

Content licenses

Clear browsing data | | Cancel |

@ Some settings that may reflect browsing habits will not be cleared. Learn more
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4. From the Obliterate the following items from drop down menu, select the beginning of time
option.

5. Select the Browsing History, Download History, Cookies and other site and plugin data,
and Cached images and files checkboxes.

6. Click the Clear Browsing Data button. The Settings window returns.

0 eHealth Ontario [It« x ¥ £ Settings x

L C' & [O chrome://settings

3 Apps For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...

Chrome Settings
Fistory Privacy
Extensions Content settings... Clear browsing data..
I Settings Google Chrome may use web services to improve your browsing experience, You may optionally disable these

services. Learn more

About

LY

Use a web service to help resolve navigation errors

&

Use a prediction service to help complete searches and URLs typed in the address bar

4

Use a prediction service to load pages more quickly

Automatically report details of possible security incidents to Google

&

Protect you and your device from dangerous sites
Use a web service to help resclve spelling errors
Autematically send usage statistics and crash reports to Google

Send a "Do Not Track” request with your browsing traffic

Passwords and forms

| Enable Autofill to fill cut web forms in a single click. Manage Autofill settings

| Offer to save your web passwords, Manage passwards

Web content
Font size: Medium ¥ || Customize fonts.. |

Page zoom: 100% hd

7. Scroll to or locate the Privacy settings heading and click the Content Settings button.
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8. Under Cookies, click the keep local data only until you quit your browser radio button.
0O cHealth Ontario | It= % ) £ Settings - Content s- X

€ - C A |[3 chrome//settings/content @ A =

if! Apps For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...

Content settings

Cookies
) Allow local data to be set (recommended)
'j;' Keep local data only until you quit your browser
) Block sites from setting any data

[7] Block third-party cookies and site data

Manage exceptions... All cookies and site data...

Images
‘® Show all images (recommended)
Do not show any images

| Manage exceptions... |

JavaScript

® Allow all sites to run JavaScript (recommended)

) Do notallow any site to run JavaScript

| Manage exceptions... |

Key generation

Done

9. Click Done.
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Enabling Google Chrome’s Incognito Mode

Follow the steps below to add a command-line option to the Google Chrome shortcut and activate
Incognito mode.

Note: Incognito mode is not the same as anonymous browsing. Websites and other sources can still track
your activity and IP address information in this mode. This mode only specifically removes your browsing
history, cached web pages, cookies, password, and auto-filled form data after your browsing session ends.

1. Right-click the shortcut you use to launch Google Chrome. It will either appear on your desktop,
Start menu, or taskbar.

| Tasks ' Open
& MNew window % Run as administrator

€ New incognito wi Unpin from Tackbar

2. Select Properties in the menu that appears. For example, if you are using a taskbar shortcut on
Windows 7 or 8, you will have to right-click the Google Chrome icon on your taskbar, right-click
Google Chrome in the list, and select Properties.
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3. Clickin the Target field.

General | Shoricut |Cnmpaﬁbiiity | Securityl Delailsl Previous Versions|

g Google Chrome

Targettype: Application

Targetlocation: Application

Target iData\Local\Google\Chrome\Application\chrome. exe

Start in: C\Users\|AppData\Local\Google\Chrome\Applicatio

Shortcut key: MNone

Run: lNolmal window - ]

Comment: Access the Internet

Open File Location H Change Icon... H Advanced... I

Cancel I [ Apply

4. Move your cursor to the end of the path shown.
5. Type <—incognito> (that's a space character, a dash, and then the word incognito).

6. Click OK after adding this option. Google Chrome will now start in incognito mode when you launch
it via this shortcut. If you use other shortcuts to launch Google Chrome, you will need to modify them,
too.
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Managing Your Google Chrome Downloads Folder

Follow the steps below to view, manage, and delete the contents of your Downloads folder.

1. Find your current Downloads folder. Click on the Settings icon ( = ) in the upper-right corner

your Google Chrome browser window.

;fflj eHealth Portal - Hor x
€& — C & @ https://www.ehealthontario.ca/portal/server.pt/community/home/3090 s Q =

i** Apps  For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...

eHealth PORTAL —

Applications Collaboration Partners b

4§ Home >

eHealth On “

- I
Log in to eHealth Portal News and Updates |

Please enter your user name and password. PR “pgmde:]-

If you're running an
User name : systems (O3) versio!
| | Warning messages’
Portal. Over the nex
Password : Ontario will be upgr
and web site cerific
| | me?

@ ONEEMail Lagin und
= . The new ONE Mail |
, . to login to Cutlook V
Issues with your Login? to find out more abo.

Applications = ONE

MH/SL user login

< N/ / R
About DPV About OLIS About Par
Drug Profile Viewer Ontario Laboratories Information System -
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2. Scroll down to the Downloads settings. If you do not see Downloads, scroll down and click on
Settings -> Show advanced settings...

3. Scroll down to Downloads and note (Ctrl + C) the download location that is displayed.

W O eHealth Ontario | It's x i ¢ Settings x i ﬁ

€ = C A |[O chromey//settings

i1 Apps For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...

Chrome Settings Search
Histary | Language and input settings..
Extensions

[ Offer to translate pages that aren't in a language you read. Manage languages

I Settings
Downloads

About Download location: |

[[] Ask where to save each file befare downloading

HTTPS/55L

| Manage certificates...

Google Cloud Print
Set up or manage printers in Google Cloud Print. Learn more

| Manage

[} Show notifications when new printers are detected on the network

Accessibility

Add additional accessibility features

System

¥ Continue running background apps when Goagle Chrome is closed

|| Use hardware acceleration when available

4. Click on the Windows Start icon at the left hand bottom of your desktop.
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5. Click Documents.

C‘% Smippng Tool

E Macrosoft Access 2000

Green, klarion

éa Microseft Office Cormmunicater
2007 R2
. Docurments
Yl :
[P powerpoint 2010
Pictures

OF outiook 2010
N |

ok Vit

@ Werd 2010

Computer

iE"J Microsoft Excel 2010

Contred Panel

n Acrebat Reader DT Devices and Printes:

&; Microseft Viso 2010

E Bunticulate Storyling 2

Windows Media Encoder sl
Edition

[efan

= Calculater

L,L Adcbe dcrobst X Pro

0 Network Recarding Player

B Al Programs

I.\'u:".'.'r:'r programsg and f
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6. Atthe top of the Documents library property sheet that appears, locate the Navigation bar, shown
circled.

L TS e (S |

CYC) - > tion. » Documens >~ 9| SearcnDocumens 9|

Organize * Share with « MNew folder = - ED ﬁ
1
Some library features are unavailable due to unsupported library locations. Click here to .. X
L1 ) -
.. Favorites —
] Docu ments_ library ..
M Desktop Includes: 2 locations
143 Downloads S A
«» Recent Places R
'@ My Data Sources
] Libraries 3 ¥ My Music i
_*, Documents k My Pictures
. Music | My Received Files
5L Pictures J My Shapes
Q, Videos B My Videos
L | OneNote Notebooks
& Computer | Personal
& Windows (C) | Snagit
= My Documents (\\ont I Training B
=a 23 items
L
< ___-;r

7. Clear the contents there and enter (Ctrl + V) the location you recorded for the Downloads location.
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Organize ~ Share with = New folder =~ O @
4 . Favorites Name r
B Desktop | DRIVERS
s Downloads | Intel
«» Recent Places I Logs
3 MSOCache
4 7] Libraries 1l | Program Files |
> |, Documents | Program Files (x86) 3
b . Music ProgramData
[> =1 Pictures | Users
> & videos - | Windows
| WMSecDoc
2k Computer | adobereader_dc_install LS4
| b & Windows (C) | | IFRToolLog 1l
b | scans v >
13 items
-

8. Press Enter. The contents of your Downloads folder will display.

9. To select all files in the folder, click the Edit menu and select Select All.
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File Edit View Tools

= Recent Places

@ Documents

J? Music

[ Pictures

@\’:jv| 4. » Green, Marion » Downloads »

- | 3 | | Search Downloads

|_§_. ConnectingOntaric Northern and East

. Marion |_L ConnectingOntaric Termnplates.zip
| | 1) ConnectingOntario Greater Toronto A
4 Libraries | 1) ConnectingOntario_GreaterTorontoAr

|_§_. Wordmark-English.zip

| | 1) ConnectingOntario_Wordmark_En.zip

| | 1) ConnectingOntario_GreaterTorontoAr

m

Organize = = Open Mew folder ==« O @
-
& E-dE Wir
W0 Favorites Name o 1‘%.
.
BE Desktop |_L BrandAssets.zip
& Downloads |@ Internal Email Broadcast.oft .

B videos

replay.exe
| storyline-2.exe
18 Computer |0 Maricn Green's Personal Room-20160]
'L"' Windows [C) |O Marian Green's Personal Room-20160]
# kyoto (\ixtlan) (Z:) |@ UtilityOnlineMarch092009_03.exe
|m lastpass_x04.exe
G‘ﬁ Metwork |0 Maricn Green's Personal Room-20160!
|O Marion Green's Personal Room-20160!
| B Maricn Green's Personal Room-20160!
|O Marion Green's Personal Room-20160! i

4 (L 2

27 items selected
Show more details...

10. Click the File menu bar and select Delete. The Delete Multiple Items warning message appears.

Delete Multiple Items

"‘_: Are you sure you want to move these 27 items to the Recycle Bin?

pr 3

s |

Yes Mo ]
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11. Click Yes. Your files will be moved to the Recycle Bin (typically located on your desktop). A

progress bar appears.

-

= Recycling 27 items (640 MB) = &
Recycling 27 items (640 MB)

F

from Downloads (C:\Usersmarion.green’\Downloads)
Discovered 27 items (640 MEB]...

¥ More details

12. Check that the selected downloads folder is empty. If the “This folder is empty” message does not
display, repeat steps 8 through 10 until the Downloads folder is empty.

N - -
@uv| .« Marion » Downloads - | 5f| | Search Downloads 0o |

File Edit View Tools Help
Organize - Include in library - Share with = MNew folder =« 0 @

. Mame
W Favorites

Bl Desktop This folder is empty.
& Downloads
=l Recent Places

. Marion

- Libraries
@ Documents

J‘i Music

Pictures
& _ Select a file
E Videos to preview.

18 Computer
£, Windows (C3)

L kyoto Mixtlan) (Z:)

c‘ﬁ MNetwork

1| m 3

0 items
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13. On your desktop, right-click the Recycle Bin icon. Select the Empty Recycle Bin option.

-~

™~
&
ey

B EEVEI b 1T

14. On the Delete Multiple Items warning message, click Yes.

Delete Multiple Items @

Are you sure you want to permanently delete these 32 items?

15. Open the Recycle Bin icon on your desktop. The contents of your Google Chrome Downloads
folder are now removed.

s
-

(I=teypell= (3ha)
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Microsoft Internet Explorer

You should be clearing your browser cache whenever you exit Microsoft Internet Explorer; however, an
alternative is to set up Microsoft Internet Explorer to always browse in what is known as Private mode.

Private mode ensures that browsing history, cookie information and browsed pages are not saved on your

computer. By default, most browsers save these items. You should also be clearing the items in your
Downloads folder on a regular basis. The instructions for these activities are described below.

Enabling Microsoft Internet Explorer Browser History and Clearing File Cache
Follow the steps below to clear your browsing history and cache.

1. Inyour Microsoft Internet Explorer browser window, click the Gear icon (‘3§}') and select Internet

options.
- = -
a = aboutblank D~ & X || & Blank Page | @'

Print r
File ¥
Zoom (L005E) k
Safety k
View downloads Ctri+)

Manage add-ons

F12 developer tools

Go to pinned sites
Clternet options 3

About Internet Explorer

2. Onthe Internet Options property sheet that appears, click the General tab.

3. Click the Delete browsing history on exit checkbox.
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General | Security | Privacy | Content | Connections | Programs | Advanced| I

Home page I
Q To create home page tabs, type each address on its own line.
-
l http:/femerge/ -
| Use current | | Use default | | Use new tab
Startup

Start with tabs from the last session
(@) Start with home page
Tabs

Change how webpages are displayed in tabs. Tabs

Browsing history

Delete temporary files, history, cookies, saved passwerds, and
web form information.

|| Delete browsing history on exit

[ Delete... H Settings ]

Appearance

[ cdors | [ tanguages | [ roms | [ Accessiny |

@ Some settings are managed by your system administrator.

Lo J[ ot [ apey |

4. Click Delete. The Delete Browsing History property sheet appears.

5. To customize which types of data Internet Explorer will clear, select only the check boxes shown in the
Delete Browsing History property sheet below.
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Delete Browsing Hi

Preserve Favorites website data
Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

Temporary Internet files and website files
Copies of webpages, images, and media that are saved for
faster viewing.

Cookies and website data
Files or databases stored on your computer by websites to save
preferences or improve website performance.

History
List of websites you hawve visited.

["] Download History
List of files you have downloaded.

|:| Form data
Saved information that you have typed into forms.

["] passwords
Saved passwords that are automatically filled in when you sign
in to a website you've previously visited.

["] Tracking Protection, ActiveX Filtering and Do Not Track ¢
A list of websites excluded from filtering, data used by Tracking
Protection to detect where sites might automatically be sharing details
about your visit, and exceptions to Do Not Track requests.

About deleting browsing Delete l & Cancel
history

6. Click the Delete button. Internet Explorer will immediately clear your private data and then clear it
each time you close your browser.
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20



7. On the Internet Options property sheet, click Apply.

8. Click OK.

General |Semrity | Privacy | Content | Connections | Programs | .ﬁd'u'an::ed|

Home page

l To create home page tabs, type each address on its own line.
=

http:/femerge/ -

IJse current | | |ze default | | Lse new tab

Startup
Start with tabs from the last session

i@ Start with home page

Tabs
Change how webpages are displayed in tabs.,

Browsing history

Delete temporary files, history, cookies, saved passwords, and web
form information.

Delete browsing history on exit

[Delte, [ Settngs

Appearance
[ | e | |

@ Some settings are managed by your system administrator,

[DK HCE’"CE'][&W!‘:
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Enabling Microsoft Internet Explorer Private Browsing

To enable private browsing, you will need to add a command-line option to your Microsoft Internet
Explorer shortcuts. This will activate InPrivate browsing by default. InPrivate browsing helps prevent
your browsing history, temporary Internet files, form data, cookies, and usernames and passwords from
being retained by the browser, leaving no easily accessible evidence of browsing or search history.

Note: Private browsing is not the same as anonymous browsing. Websites and other sources can still
track your activity and IP address information in this mode. This mode only specifically removes your
browsing history, cached web pages, cookies, password, and auto-filled form data after your browsing
session ends.

1. Right-click the shortcut you use to launch Internet Explorer and select Properties.

Open

% Run as administrator

Pin to Taskbar

2. Inthe Internet Explorer Properties property sheet below, type <—private> to the end of the
Target box (that’s a space, one dash, and then the word private). Click OK.

When you use this shortcut, Microsoft Internet Explorer launches with InPrivate browsing enabled. If

you use other shortcuts to launch Microsoft Internet Explorer, you will need to modify each one.

Guidelines for Managing Google Chrome and Internet Explorer / Version 1.0
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General | Shortcut | Compatibility | Security | Details | Previous Versions |

@ Internet Explorer

Target type: Application

Target location:  Internet Explorer

Target "C:\Program Files\Internet Explorefiexplore.exe"|

Startin: %HOMEDRIVE % %HOMEPATHY

Shortcut key: Mone

Bun: [Nolmalwinduw vl

Comment: Finds and displays information and Web sites on the |
Open File Location ] ’ Change lcon... ] ’ Advanced... ]

[ 0K ] ’ Cancel ] | Apply

) iemet o Popercs W s

i
||
|

Guidelines for Managing Google Chrome and Internet Explorer / Version 1.0

23



Managing your Microsoft Internet Explorer Downloads Folder
Follow the steps below to view, manage, and delete the contents of your Downloads folder.

1. To access your download history, find your current Downloads folder.

mie https:/ /veww.eheal., © = ﬂﬂ”@d—hﬂth?uml Home =<| | ok L
File Edit View Favorites Tocls Help
¥ @ Convent w [B) Select
ks () WebEx Meeting Center 2| Technical Service Lead As.. " - * [ pm v Pagew Safety~ @* g
sHesith OntSM="Francais A
2Health PORTAL Search
Applications Coliaboration Pariners How To Use F
S
Home >
R
Log in to eHealth Portal News and Updates
Pleaze enter your user name and password. Enterprise Upgrode: TLS and SHA.Z
1 you're running an older browser or o [
User name ! uﬂm[ﬂﬁ;m YOU Iy SO0 £
1 N YOU BCCBSS ¢
| Partal ouumnemzmum aHes
Password : ‘Ontario will be upgrading encryplion p
ond web site cerificaies. How does th
— m'l
hm OMEEMil Login and lafe
e s The new THE Mail page enables &ds!
F: . o login to Outlook Web Access and m
Issues with your Login? fo find out more about ihe senvice. Fin
Agpphcations > OME Mai
MH/SL wser kogn
W \
f |
< = v ! Ry
About DPV About OLIS About Panorama
< >

2. Inyour Microsoft Internet Explorer browser window, click Tools, shown circled, and select View
Downloads.
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3.

In the View Downloads window, click Options.

View and track your downloads

Search downioads

Mame Location Actions
BrandAssets.zip 496 ME  Downloads =
Open |~ |
Emerge 1
Internal Email ...oft 505KB  Downloads — =1
Open |¥|
emerge
ConnectingQ...zip 529MB  Downloads |
-
- _ Open |7
ConnectingQ...zip 525MB  Downloads |
Open |+
emerge - :
ConnectingO...zip 537MB  Download |
ng P ownloads ez
[% SmartScreen Filter is turned off, Turn on
(>, [ Gt [ Gloe

4.

In the Download Options window, click Browse.

Default download location:

Downloads

Motify me when my downloads are complete
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5.

In the Select a default destination folder for your downloads property sheet, click the

Navigation bar.

ﬁMaﬁw

558

1% Computer
ﬂ. Windows (C:)
% kyoto (\\ixtlan) (Z:)

?! MNetwork

Folder:

{ ” i@ﬂm, Maron » Downloads ) 4y r | Search Downloads 2 |
Organize = Mew falder =] - (7]
0 Favorites Mo items miatch your search.

Bl Desktop
& Downloads
| Recent Places
. Marion

4 Libraries
*| Documents
@' Music
b= Pictures
B videos

| Select Folder

6. Copy the contents by pressing Ctrl + C (at the same time).

7. Click Cancel.
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26



8. Inthe Download Options window, click the Cancel button.

Default download location:

Downloads | Browse. .. I

Maotify me when my downloads are complete

9. Inthe View Downloads window, click the Close button.

View and track your downloads Search downloods »
MName Location Actions
[ SmartScreen Filter is turned off, Tum on

N r "
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10. To open Windows Explorer on your desktop, click on the Windows Start icon in the lower-left area of
your desktop.

11. Select Documents.

C‘% Snippng Toal

E Macrosoft Access 2000

Green, Marion

éa Mcroseft Office Cormmunicater
X007 R2

- Documents
[P powepoint 2010

Pictures

OF outiook 2010
L |

k4 Fitla

@ Werd 2010

Computer

(9 picrosot Excel 2010

n Fcrobat Reader DT

Contral Panel

&; Ilicrosedt Visio 2010

E Adticulate Storgfine 2

Windows Media Encoder xfd
Editian

Calculator

|.,L. Adobe Acrabat X Pro

0 Metwark Recarding Flayer

b Ali Programs

I}-.".‘.‘":"’ BrOQ e ang faes
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12. Inthe Documents Library property sheet, locate the Navigation bar.

L

w | by u Secrch Docurnents
Organize Share with = Mew Tolder = B n
W -mes DOCUM... \ . ceby Folder =
Desktop
& Downlosds Hame ek
"L Recent Places -
B Maion |0 My Anticulate Prajects
L. wdrive
i Libraries 0 My Muic
[ Docu = My Pictures
o Music B My Videos e
B3 Pictures 1. SharsPeint Drafts |
B Videos L thi Selectafile |
i
L Scanned Documents bo pooew.
1 Computer di Selftay
&L Windows (€ |, Outlook Files ]
L boyoto (Vitlan) (Z:) O Vistnk oo 2
1. OneMote Notebooks
G Network i My Meetings
i) My Shapes
| My Received Files
i samsung
. [h%ﬂ.. ,
23 ftemns
-~
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13. Clear the contents of the Navigation bar and paste (i.e., press Control + V at the same time) the
location you have previously recorded (copied) for the Downloads location.

14. Press Enter. The contents of your Downloads folder will display.

@QV| & Ch\Users\marion.green\Downleads - | 4 | Search Downloads I
File Edit View Tools Help
Organize « Include in library « Share with « Slide show Mew folder = - O l@'
[ Favorites Mame -
B Desktop 1) BrandAssets.zip
4. Downloads @ Internal Email Broadcast.oft
£ Recent Places 1) ConnectingOntaric Morthern and East
. Marion 1) ConnectingOntario Templates.zip
1) ConnectingOntaric Greater Toronto A
73 Libraries 1) ConnectingOntario_GreaterTorontohr
3 Documents 1) Wordrark-English.zip 3
;J'- Music 1) ConnectingOntaric_Wordmark_En.zip
=] Pictures EN ConnectingOntario_GreaterTorontofr )
) Select a file
B videos B replay.exe to preview.
ﬁ storyline-2.exe
18 Computer O Maricn Green's Persenal Room-20160°
‘:_f Windows (C:) O Marion Green's Personal Room-20160°
L kyoto (ixtlan) (Z:) @ UtilityOnlineMarch092009_03.exe
m lastpass_xhd.exe
&l'j Metwork i@ Marion Green's Personal Room-20160"

0 Marion Green's Persenal Room-20160!
&) Marion Green's Personal Room-20160!
0 Maricn Green's Personal Room-20160!

1| [1l] | 3

27 items

Guidelines for Managing Google Chrome and Internet Explorer / Version 1.0



15. To select all files in the folder, click the Edit menu and select Select All.

File Edit View Tools Help

Organize « = Open Share with

w{ Favorites
Bl Desktop
4. Downloads
=] Recent Places
. Maricn
= Libraries
@ Documents
J‘i Music
[&=| Pictures

H videos

Lol Computer
&, Windows (C3)
L kyoto (Mixtlan) (Z:)

'?j Mebwork

27 items selected
Show more details...

@’Qv| &+ Green, Marion » Downloads »

E-rmail

- | 5 | | Search Downloads

Mew folder 4= -

Mame

|_§_ BrandAssets.zip
@ Internal Email Broadcast.oft
| 1) ConnectingOntario Morthern and East

| 1) ConnectingOntario Templates.zip

| 1) ConnectingOntario Greater Toronto A
| 1) ConnectingOntario_GreaterTorontoAr
| 1, Wordmark-English.zip

| 1) ConnectingOntario_Wordmark_En.zip
| 1) ConnectingOntario_GreaterTorontoAr

] replay.exe

storyline-2.exe

O Marion Green's Personal Roomn-201607
0 Marion Green's Personal Room-201607
@ UtilityOnlineMarch092009_03.exe

m lastpass_x6d.exe

O Marion Green's Personal Roomn-20160!
O Marion Green's Personal Room-20160!
B Marion Green's Personal Room-20160!
O Marion Green's Personal Roomn-20160!

(L k

m

16. Inthe File menu, select Delete. The Delete Multiple Items warning message appears.

Delete Multiple Itermns

»
L=

‘_"1—' Are you sure you want to move these 27 items to the Recycle Bin?

[

Yes MNao ]
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17. Click Yes. Your files will be moved to the Recycle Bin normally located on your desktop. A progress
bar appears.

from Downloads (Ch\Users\marion.greentDownloads)
Discovered 27 items (640 MEB]...

-— |

-
'Q")More details Cancel
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18. Check that the selected Downloads folder is empty. If the “This folder is empty” message does
not display, repeat steps 8 through 10 until the Downloads folder is empty.

cearch Downloads o

@Qv| , « Marion » Downloads v|#?|

File Edit View Tools Help
Organize * Include in library « Share with + Mew folder =« O @

. Mame
[ Favorites

Bl Desktop
4 Downloads

This folder is empty.

.
=il Recent Places

. Marion

- Libraries
3 Documents
,J'. Music
| Pictures .
. Select a file
B videos to preview.

18 Computer
£, Windows (C:)

L kyoto (\ixtlan) (Z:)

&h Metwork

4 LI 2

0 items

19. Right-click the Recycle Bin icon on your desktop and select the Empty Recycle Bin option. A
warning message appears.

Delete Multiple Items @

Are you sure you want to permanently delete these 32 tems?

- Ce D w
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20. Right-click the Recycle Bin icon. The Empty Recycle Bin option should be greyed out. If it is not,
repeat steps 15 through 17.

21. The contents of your Microsoft Internet Explorer Downloads folder are now removed.

e
i

(ool 31l
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